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Seminar Type

Microsoft Products

Seminar Level

Advanced: An advanced level course facilitates the development of thoughts (ideas,
theories, procedures) to the most advanced stage possible. For functional courses, the
objectives taught at this level challenge learners to analyze and make business
decisions on how to utilize the agency management system or software in their agency,
or apply a high level of technical aptitude to understand in depth features and
functionality.

Class Description

You will learn in both Epic and TAM how to create a form such as a company-specific
application or a performance bond which prefills with the client’s information from your
database.

Learning Outcomes

1. You will have two methods of creating a form that looks just like the non-
TAM/Epic document, and the pros and cons of each method

2. You will be able to get a carrier-specific application (such as EPLI or D&O) to
print from within your system with the client data pre-filled

3. You will be able to generate a township’s performance bond, or the state surplus
lines affidavit, without going to the typewriter

Assumptions

This seminar is based on the following
TAM Version 2012/2015
Epic Version 2013/2015
Microsoft ® Word Version 2010
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Introduction

If your agency is like many agencies, even though you may use your TAM or Epic
system for formletters and proposals, there are still forms that are completed manually
(e.g., bond forms, special certificates). Besides having to be done “one by one”, this
manual completion of forms creates an issue of how to attach them to the customer.
You can utilize the Applied/Word interface to create these forms so that they pull
information stored in the database as well as automatically attach to the customer.

In today’s industry, insurance companies and municipalities often provide copies of
these special forms via an internet website or the underwriter provides the form via
e-mail.

There are two ways to create forms in TAM and Epic. You can import an image of the
form and use it as a “background” with the Applied data fields overlaid on the image or
you can recreate the form directly in Word and incorporate the data fields into the form.

Why do we demonstrate two methods? Because each has advantages. Using an image
file is quicker and easier — you do not have to spend a lot of time replicating the look of
the form in Word, which can involve choosing a font and adjusting font sizes, and
creating tables that allow you to place the information in the right places on the form.
However, the disadvantage of this method is that the data and the form are basically
independent of each other — if the data on a particular client takes up an extra line,
everything else on the page will be pushed down and it won’t line up with the text in the
image. This can’t happen when you build the form in Word.

The example we will use in this tool is the New Jersey Surplus Lines Affidavit. This is a
form that must be completed by the agent on every surplus lines policy written on a risk
located in New Jersey. This particular form is specific to New Jersey; however, most
states have a requirement that a similar form be completed on surplus lines risks, so it
is used frequently in agencies. Speeding up the completion of the form will improve
efficiency in the agency.

The form is shown on the next two pages.
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Transaction Number

STATE OF NEW JERSEY
DEPARTMENT OF BANKING AND INSURANCE
SURPLUS LINES EXAMINING OFFICE
P.O. BOX 325
TRENTON, NEW JERSEY 08625-0325

CERTIFICATION OF EFFORT TO PLACE RISK WITH AUTHORIZED INSURER

This certification shall be submitted by the originating producer to the surplus lines agent, within 30
business days after the effectuation of any surplus lines insurance. The original of the certification must be
maintained in the files of the surplus lines agent and a copy in the files of the producer and both must be
available for inspection by the Commissioner for a period of at least five years.

{Name of Insured)

{Address of Insured)

{Location of Property or Risk)

{Insurance Coverage: Description and Amount)

e e e e T e

{Originating Producer — Corporate or partnership)

{Originating Producer — Individual name and/or Title)

{Originating Producer — Complete Address)

The above hereby certifies that he/she is duly licensed as an insurance producer under the laws of New
Jersey, and that: On or about , 20, 1 was engaged by the insured named
herein to procure insurance of the kind described heremn and in the amount shown. 1 have made a diligent
effort first to place this coverage with authorized insurers, each of which is authorized in New Jersey to
write insurance of the kind requested and 1s an insurer that 1 had a good faith reason to believe might
consider writing the type of coverage described heremn.




Certification of Effort To Place Risk With Authorized Insurer (continued)
Page 2 of 2

The following insurers are among those that I contacted relative to this risk, or to substantially similar risks
within the past 30 days:

INSURER REPRESENTATIVE TELEPHONE NO. DATE RESULTS
CODE*

*Result Codes: (enter appropriate code(s) for each insurer listed above)

A. —Having made a diligent effort. [ was unable to obtain an offer/quote from this authorized insurer
in the admitted market, which declined to accept all or any part of the risk.

AND/OR

B. -- Having made a diligent effort, the only offer (s)/ quote(s) obtained reflected such a substantial
increase in premium over similar coverage placed within the preceding 12 months that comparable
coverage is, as a practical matter, unavailable from this authorized insurer in the admitted market.

AND /OR

C. -- Having made a diligent effort. , the only offer (s)/ quote(s) obtained reflect(s) such a substantial
reduction in coverage from coverage placed within the preceding 12 months for substantially
similar premium that comparable coverage is, as a practical matter, unavailable from this
authorized insurer in the admitted market.

I certify that the foregoing statements made by me are true to the best of my knowledge and belief. T
am aware that if any of the statements are willfully false, I am subject to civil and criminal penalties.

(Date) (Signature)

Amended by R.2005 d.104, effective April 4, 2005,
See: 36 N.J.R.2144(a), 37 N.J.R.1065(a).

L:\Sections\OSR'Surplus Lines'Forms'SLP §-6-CERT-1-{2005).doc
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Creating a Form Using an Image
Each page of the blank form needs to be saved as an individual image file.

Here are the steps for creating a form.

e In TAM, access Document Setup through Utilities.
In Epic, access Attachments, Templates through Configure.

e Create a new formletter (TAM) or template (Epic) by completing the document
setup information as necessary.

e Once Word is open, from the Insert tab on the ribbon, select Header, Edit
Header. With the Header open, from the Insert tab on the ribbon, select Picture,
From File. Browse to the location where you stored the form image file, select it,
and click Insert.

Picture Taols Revised Integrating Word and Applied.docx [Compatibility Madi
View Developer Format
i‘ | | ﬂ o) L S|l 0 eght (236 :
Position Teut Align Rotate Crop '-T:'L"“:“r' 552" =
hd .‘.'rdpp:rq ®
Arrange Sizg
b |
Change Position to Change Text Wrapping to Change Height/ Width
Centered on Page Behind Text to match Paper Size

e On the Picture Tools Format tab on the ribbon,

make the changes shown above. Depending on ||~ =" ‘p.a'fg‘:fh. S——
the height to width ratio of your particular image, P~ i
you need to decide which dimension takes '
precedence — don’t exceed the paper size with 1

either dimension.

e Close the header by clicking anywhere in the
main body of the document.

e Adjust the left margin to coincide with the point
where you will want data to begin on the form.

Adjust left margin so your
text will begin at the

. .| correct point on the form
mber SLPS-6-CE}l

1

STATE OF NEW
DEPARTMENT @F BANKIN
SURPLUS IINES EXAM

P.O. BOX
IRENTON, NEW JERS

CERTIFICATION OF EFFORT IO PLACE!

e R R R R R R R

e You can now type "on top" of the image - inserting data fields, ASK variables, etc
as needed.
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As you enter the data fields, you will sometimes find that they wrap onto the next
line, even though the actual data at the client level will not. When this happens,
you have to put subsequent data fields one line below where you want them to
appear on the image. Also remember that this effect is cumulative — every time
data fields wrap to the next line you have to drop the following entries by one
more line.

Hint: You can check to see if you have your entries on the correct lines by turning
off View Field Codes by pressing Alt-F9 on your keyboard. In most cases, this
will reduce the space the data fields take up so that they fit on a single line.

If necessary, you can use Font size and/or Line Spacing to adjust the vertical

placement of the text and data fields so that they line up exactly on the lines in
the background image.
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e To create the next page, you need to insert a section break so you can change
the header and insert the second page image.

On the Page Layout tab on the ribbon, select Breaks, Section Breaks, Next
Page.

On the second page, the first page image is repeated in the header. That’s
because by default the header is linked to the previous section as shown here.

Foaker -Seckion 2- Same as Previous

Header -Section 2- Same as Previous

e On the Header & Footer Tools Design ribbon, unselect the “Link to Previous”
box. You can now delete the first page image from this header without its being
deleted from the first page, and insert the second page image using the same
process described earlier. The image below shows the results.

Footer -Section 1-

Header -Section 1- Section Break {Mext Pages:

‘L L

Header -Section 2-

Certification of Effort To Place Risk With Authorized Insurer (continued)

e Close the Header and Footer.

e You can now complete the entry of the data fields onto the image in the same
way as you did for the first page.

Creating a Form Using the Applied/Microsoft® Word®Interface // PAGE 11

Applied Client Network | www.appliedclientnetwork.org



SESSION HANDOUT
Creating a Form Using the Applied/Microsoft® Word® Interface A A IZL!:nIt-NIeEvak

Creating a Form Directly in Word

Another option for creating forms in Word is to build the form manually, not using an
image as a background. Some pre-planning is called for regarding the layout and
general design process.

Review the form that you are replicating and consider the following points.

e What font should you use?

e |Is there alogo you need to create as an image file to insert into the form?

e Will you need to use tables to replicate parts of the form, while other parts will be
simple text entries? The benefit of using tables is that you can force a table cell
to remain a constant size regardless of the amount of data that is being imported
on any particular client.

e Can the form be broken down into logical sections? For example, a certain area
has five columns across that should be one table while another area has a series
of one column rows that should be another table.

e Once the document setup areas have been completed and the empty document
is open in TAM or Epic, set the page width, margins and font to match the
original document.

In our example, we will start by entering the top part of the form without a table.

Form Number- SLPS-6-CERT-1 —+ L A B B o S Y L S Y N |

. — Tranzaction'Number®

- STATE-OF-NEW-JERSEYY
DEPARTMENT: OF - BANKING: AND-INSURANCEY
SURPLUS: LINES-EXAMINING- OFFICEY
P.O-BOXA13T
TRENTON,NEW-JERSEY -08625-03259
Ly
Ly

CERTIFICATION-OF-EFFORT-TO-PLACE-RISK-WITH-AUTHORIZED-INSURERY

p
This- certification shall be- subrmitted- by- the- originating: producer- to- the- surplus- lines- agent,- within- 30-
business-davys-afterthe-effectuationof-anv-surplus inesinsurance - The-original-o fthe-cemtificationmust he-
maintained-in-the- files-of the-surplus-lines-agent-and- a- copy-in-the- files-ofthe producerand both-must be-
available-forinspection-by the-Commuissioner for-a period-ofatleast-five-yvears ¥

p

For the next part of the form, we will create a table 8 rows deep and 1 column wide. The
first row will be where we put the Client Name data field; the second row will contain the
text “(Name of Insured)”. We will create the appearance of the lines by turning on either
top or bottom borders for the rows with data fields in them.
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On the Table Tools Layout tab on the
ribbon, select Properties then Options.
Uncheck the box “Automatically resize to fit
contents”. This will allow you to control the
column widths without Word changing them

when you put data fields in them.

Next, go to Borders and Shading
and turn off all of the Borders
(after entering the text you will
come back in here on selected
cells and turn on the Top Border)

A

APPLIED

Client Network

Table Properties x|
Table | Fow | Column I Cell I
Size
™ Preferred width: ID" ﬂ Measure in: IInches j
alignment: - IO 3 4| S—
EE Defaulk cell margns ———————————————
== Im [0 = Lefn oo =
| et o =] Rioht: jooe" =
Led
Text wrapp Default cell spacing ——————————————
™ allow spacing between cells 0" 5‘
El; slstis | Uncheck this box
v autpmatically resms
Mone i _ Eioming, .. |
Ok I Cancel |
Borders and Shading... | Options. .. I
QK | Cancel
Borders and Shading x|
Borders | Page Border | Shading |
Setting: Style: Prewview
- EI - Click on diagram belov or use
Hone buttons ta apply borders
Select None for Borders
B o
Ba -
=
Color:
E Grid [~
I -
width: /‘| | || ’\|
E Custom 1% ok
. F - Apply kot
ITab\e j
Dptions. . . |
Harizontal Line... Cancel |
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e Enter the text in the appropriate rows and turn on the Top Borders in those rows
as described above. Your table should now look like this:

[#]

iName-of Insured ¥

(Addressofinsured®

[SRN ]

iLocation-of*Propertv-or-Fisk)¥

[SRNS]

(Insurance-Coverage:Description: &-Amount 2

[SRNS]

e Next, put the data fields in the rows above their captions. You will see that we
are using ASK variables to gather some information that isn’t available in the

database.

<CUSTINS NAME=-<CUSTINS ATTN=2 o
(Name-of-Insured ) il
. <CUST INS STREET=_<CUST INS CITY=<CUST INS §T=<CUST INS ZIP=x o
In TAM |t |OOkS (Address-ofInsured)? =
Ilke thls #Ask-LOCATION-"Whats-location-of property-or-tisk?" \d-" "3 RefLOCATION$2 =
(Location-of-Propertyv-or-Risk)® hel
#Ask: COVERAGE-"Whatis-description-and-amount-of-coverage?" \d-"- "} Ref jot

COVERAGEH

AV T AORB R e A8 T oS, B 4T CAGIAN O e o, 0T T SOt
' maintained’in-the files-of the-surplus-lines-agent-and-a-copy-in-the-files-of the producer’and -both-must-
"z be-available- forinspection-by-the-Commissioner- for-a period -of five vears ¥

[

A

;_."-" # DOCVARIABLE MasterAccountMerge.Account. Common.Common.AcctName*0*1-
i (Name-of -Insured )
$DOCVARIABLE MasterAccountMerge. Account. Common.Address. Address1*0%2 3
. . s  DOCVARIABLE 'MastErAccmthErge,Accuu_m,Cummun,Add_ress,City‘U'}-5}3;g'DOCVARlABLE'
And In EplC It 11 MasterAccuu.ntMergE.Acccu.m.Ccmmcn.Add.ress.StateCude'U‘S'%'}E__-_DOCVAR.[ABLE'
- [ i MasterAccountMerge. Account.Common. Address Postal Code*12*4- 22
IOOkS Ilke thIS " (Address-of Insured)™
/" §-ASKLOCATION'What-is-thelocation-of therisk? Enter in-the-format shown.”-\d "123-Main- Street.-
h... City, NI-12345™*-MERGEFORMAT £ REF-LOCATION
x (Location-of Property-or-Risk)2
/ $-ASK-COVERAGE "What is-the-description-of coverage?-Enter-in the format shown."-\d-"Fire- &-
L Allied-Perils,-$100,000"-*- MERGEFORMAT $ REF-COVERAGE jlx
S

(Insurance-Coverage-—Description-and-Amount )

e,

vy

e
£ L
4

“‘M*‘N\h"\ A .,..hu*r‘" o -—-JJ“—\‘.—-
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Continue creating the form using either text or tables as you deem appropriate. Here is
the screen shot of the rest of the first page.

-

‘_I*I'

BHB Insurance-Services™

]

{Originating-Producer:-Corporate-or- Partnership ¥

0o

{Originating-Producer:-Individual-WName-and 'or-Title)¥
PO-Box-2100_-Toms- Eiver -NJ-08574-2100
(Originating-Producer:-Complete- Address )z

0o

.
The- above-hereby- certifies- that-he/'she-is- duly- licensed- as-an insurance producerunder- the-laws of New-
Jersey,- and- that:- On- or- about- <CPOL.POLICY EFF=, I- was- engaged: by- the-insured- named- herein- to-
procure-insurance ofthe kind-described herein-and inthe-amount-shown. Thave mads-a-diligent-e ffort- first-
to- place- this- coverage: with- authorized: insurers,- each- oft which- is- authonzed- in- New- Jersey- to- waite
msurance-of the-kind-requested-and-is-an-msurer-that-I-had-a- good- faith reazonto-believe-might-consider
wiiting thetype-of-coverage-described herein®

Page Break,
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e Create the second page in the same manner. This is what the top of the page
looks like:

Certification-of-Effort-To-Place-Risk-With-Authorized-Insurer-(continued)¥
* Page-2-of29
q

Thefollowing insurers- are-amongthosze-thatTcontactedrelativetothis-nsk - or-to-substantiallv-sirmilar nsks"
withinthe-past-30-days"

HASK reasoncode-"What-is-thereason-for-SL-placement ?-Tvpe- A_-B -or-C-afterreading-
thedistbelow™d"A -No-admitted-coverage-available¥
B.-Comparable-premium-not-available?

C.-Comparable-coverage-not-available™ 7

INSURER: EEPRESENTATIVE:z ! TELEPHONE-NQO.u | DATED EESULTS
CODE-*z

b 2 a 2 FQUOTE &
REF
reasoncoded:
*upperjs

a a a a EQUOTE-
EEF-
reasoncodef
*upper

a a a 0 FOUOTE &
FEF-
reasoncodef
*upperc

(&)

[

(%]

- - -

Notice that in the table that is asking for the names of carriers that declined the
risk, there are no data or Word fields entered. Therefore, the CSR would need to
enter this info into the table after creating the form at the client level. If you
always use the same carriers and underwriters in this table, you could preset
them in the table. If you have a set you use for personal lines accounts and
another set you use for commercial lines accounts, you could have an IF
statement look at the customer code. If it's a personal code, insert one table; if
it's a commercial code, insert another table.
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